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Sign up

Four ways to Sigﬂ up

1) Sign up with email

2) Sign up with CLO and Marvelous Designer software ID
3) Sign up with Google account

4) Sign up through invitation

Sign up with email.

BETA

ARCHIVE & REVIEW YOUR 3D GARMENTS

Remember my email

Forgot your Password?

Don't have an accoun

or

Sign up with CLO and

Marvelous Designer software ID.

BETA

ARCHIVE & REVIEW YOUR 3D GARMENTS

Remember my email

Forgot your Password?

Don't have an account? Sign up!

SET

GO TO INDEX

Sign up with Google account. Sign up through invitation.

1= -7 BETA

ARCHIVE & REVIEW YOUR 3D GARMENTS

Hello Michelle Park
Remember my email

You have been invited to join the following Brand.

“ - o

INVITED BY Michelle (michelle )

Forgot your Password? n
Don't have an account? Sign up! ‘

="

or Best regards,
The CLO: Team

Copyright © 2018 CLO Virtual Fashion, Al rights reserved. hello@clo-set.com
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GO TO INDEX
Sign up

1) Sign up with email
* Access to www.clo-set.com and click ‘Sign up’ button.

. After completing the sign up form, a verification email will be sent to your email address.

Access to www.clo-set.com. Complete Sign up form. A verification email is sent. Click 'ACTIVATE' button in the verification email. Complete.

seTA Thank you for joining us! cLO
SIGN UP ) Your email has been verified!

ARCHIVE & REVIEW YOUR 3D GARMENTS
Get started with cLo A confirmation email h

Please click o

michelle@clo3d.com

This emal is available. Password Form
Hello y
Remember my email Be at least 8
P Thank you for signing up for CLOSET!
. ’ Please click on the button below to verify your email address and activate your account.
Available including letters n
and numbers
. o
fyou did not create tis acoourt, lease click here.
Match
Forgot your Pas: Best regards,
Don't have an accou n The CLO: Team
or I agree to the CLOSET Terms of Service and Privacy_Policy.

Copyright © 2018 CLO Virtual Fashion, Allrights reserved.

a
CREATE ACCOUNT
CLOSET

Already have an account? Sign in

SET



Sign up

2) Sign up with CLO and Marvelous Designer software |D

Access to www.clo-set.com and click ‘CLO’ or ‘Marvelous Designer’ icon.
Enter the ID and password used by the CLO or Marvelous Designer software.

Click the ‘Sign in’ button.

Access www.clo-set.com and click ‘CLO’ or

‘Marvelous Designer’ button.

BETA

ARCHIVE & REVIEW YOUR 3D GARMENTS

Remember my email

Forgot your Password?
Don't have an account? Sign up!

Enter the ID and password used by the software

and then click the ‘Sign in’ button.

CcLO

michelle

MARVELOUS DESIGNER

michelle

SET

After agree to Terms of Service and Privacy Policy, click 'ACCEPT' button.

use CLO you must

Terms of Service Privacy Policy
Last updated : September 02, 2015 Last updated : September 02, 2015
1. BINDING AGREEMENT 1. BINDING AGREEMENT
These terms (“Terms”) govern your use of CLO This is a legally binding agreement (“Agreement”)
Virtual Fashion, LLC’s (“CLO”) websites and between you and CLO Virtual Fashion, LLC
services such as CLO, Marvelous Designer, the (“CLO”) regarding your rights to use downloadable
C1 N Entarnrica 1icar trainina waheite and anlina €1 0 Virtiial Media and Wark Pradint
n I 1 agree to the Terms of Service I agree to the Privacy Policy

ACCEPT

GO TO INDEX



GO TO INDEX
Bl sionee

3) Sign up with Google account
Access to www.clo-set.com and click ‘Google’ button.

After agree to Terms of Service and Privacy Policy, click ’/ACCEPT' button.

Access to www.clo-set.com and click ‘Google’ button. After agree to Terms of Service and Privacy Policy, click 'ACCEPT button.

To use CLO you must first accept the terms
BETA

policy for your company.

ARCHIVE & REVIEW YOUR 3D GARMENTS

Terms of Service Privacy Policy

Last updated : September 02, 2015 Last updated : September 02, 2015

1. BINDING AGREEMENT
These terms (“Terms”) govern your use of CLO
Virtual Fashion, LLC’s (“CLO”) websites and
Remember my email services such as CLO, Marvelous Designer, the

1 O Entarnrica 1icar trainina wahaita and anlina

1. BINDING AGREEMENT

This is a legally binding agreement (“Agreement”)
between you and CLO Virtual Fashion, LLC

(“CLO”) regarding your rights to use downloadable
1O \irtial Madia and Wark Pradiint

“ n | I agree to the Terms of Service 1 agree to the Privacy Policy

Forgot your Password?

Don't have an account? Sign up!

ACCEPT
or

SET



GO TO INDEX

- Sign up

4) Sign up through invitation
+  Once you click ’ACCEPT' button in the invitation email, you can sign up with the invited email address.

+  Onlyinputting the password will complete the sign-up. The verification process is not required in this invitation case.

Click 'ACCEPT' button in the invitation email.

Enter your password. Complete.

Thank you for joining us!

SIGN UP

Get started with cLOSET You are now a member of GAP Brand.

michelle@clo.co kr
Password Form o o

n g e Be at least 8 characters including n

letters and numbers

Hello Michelle Park, onfirm Password

You have been invited to join the following Brand.
GO TO THE BRAND

BRAND BRAND

| agree to the CLOSET Terms of Service and Privacy Policy.
INVITED BY Michelle (michelle @clo3d.com)

ACCEPT .

Best regards, Already have an account? Sign in.

The CLOSET Team

Copyright © 2018 CLO Virtual Fashion, Al rights reserved. hello@clo-set.com
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Sign in

Three ways to sign in
1) Sign in with email

2) Sign in with CLO and Marvelous Designer software ID

3) Sign in with Google account

Sign in with email.

BETA

ARCHIVE & REVIEW YOUR 3D GARMENTS

Remember my email

Forgot your Password?
Don't have an account? Sign up!

or

Sign in with CLO and Marvelous Designer software ID.

BETA

ARCHIVE & REVIEW YOUR 3D GARMENTS

Remember my email

Forgot your Password?
Don't have an account? Sign up!

Sign in with Google account.

BETA

ARCHIVE & REVIEW YOUR 3D GARMENTS

Remember my email

Forgot your Password?
Don't have an account? Sign up!

or

="

GO TO INDEX



GO TO INDEX

Sign in

1) Sign in with email
*  You can sign in with the email address and password that you used with ‘Sign up with email way.

. Please confirm the email verification before sign-in.

Enter your email address and password. You are moved on the landing page.
CLOSET M

RECENT STYLES
BETA STYLES
Recent
All

Mine

ARCHIVE & REVIEW YOUR 3D GARMENTS ALL WORKROOMS

Favorite
Shared

n Rendering

michelle@clo3d.com

@ WORKROOMS

eescccce Workroom Public Room

My Comps...> Seazon My Company

B companies
Remember my email

0O mEEALE ALL COMPANIES

Forgot your Password?
Don't have an account? Sign up!

or

My Company

SET



GO TO INDEX
Sign in

2) Sign in with CLO and Marvelous Designer software ID

*  You can sign in with ‘CLO’ and ‘Marvelous Designer’ software ID if you signed up with ‘Sign up with software ID" way.

Click 'CLO’ or ‘Marvelous Designer’ button. Enter the ID and password used by the software You are moved on the landing page.

and then click the ‘Sign in’ button.

CLOSET avour (M

STYLES RECENT STYLES

BETA CcLO

Recent

All

ARCHIVE & REVIEW YOUR 3D GARMENTS ﬂ michelle Mine ALL WORKROOMS

Favorite

Shared

Rendering

© WORKROOMS
Workroom Public Room
My Comps My Company

B companies

Remember my email

[ w1 x

Forgot your Password? MARVELOUS DESIGNER

Don't have an account? Sign up!

@ VARKETPLACE ALL COMPANIES

michelle

My Company

SET



Sign in

3) Sign in with Google account

*  You can sign in with ‘Google’ if you signed up with ‘Sign up with Google account' way.

Click ‘Google’ button.

BETA

ARCHIVE & REVIEW YOUR 3D GARMENTS

Remember my email

Forgot your Password?
Don't have an account? Sign up!

or

You are moved on the landing page.

STYLES
Recent
All
Mine
Favorite
Shared

Rendering

@ WORKROOMS

B companiEs

B MARKETPLACE

CLOSET

RECENT STYLES

ALL WORKROOMS

Workroom Public Room

My Compa...> Season My Company.

ALL COMPANIES

My Company

SET

GO TO INDEX



GO TO INDEX

- Browse

Landing page
. Here you can check 1) recently updated styles, 2) all accessible styles, 3) all styles created by yourself, 4) all favorite styles, 5) all styles shared with you, and 6) all rendered images you requested for.

. You can go to your recently updated Workrooms and Companies.

*  You can purchase various sources for your work at Marketplace.

B Move to My page

CLOSET

Easily browse for the desired
Y A sTYLES RECENT STYLES

styles and spaces Recent

Favorite

[

Shared

Rendering

R Z4
CLO18072212 Tshirt1.Zprj CLO18072211 souvenir JK CLO1705003 CLO1705002 CLO1705001 CLO1612001 CLO1610013
@ WORKROOMS j i

n Move to recently

updated styles
A companies

ALL WORKROOMS

B MARKETPLACE

WORKROOM Workroom Workroom Workroom Public Room

CLO >BR... > SEASON CLO >BR... 55 - Men CLO > BR..W - Women CLO > BR..> 2017 FW co

Go to all Workrooms

ALL COMPANIES

n Go to all Companies

SET



GO TO INDEX

Upload

There are 5 ways to create a Style in CLOSET.

1) Upload a single file. In this way you can upload any formats of files related to Style, such as ZPac, ZPrj, JPG, PDF, DXF, and so on.
2) Upload multiple files. You can create multiple styles at the same time by uploading multiple files.

3) Upload Turntable images to see the style in rotating image sequences.

4) Create a blank style without uploading any files.

5)Upload a ZPrj or ZPac file in CLO Software

Click to 'Upload’ button. Lets you select the type of file that you want to upload.

CLOSET

@

SELECT FILE FORMAT

1
.ﬁ. UPLOAD ° @ CLO > BRAND > LINE > SEASON > WORKROOM «C SHARE [ LINE SHEET Al - SORTBY | Lastmodified v b

A STYLES

Recent a E
All O Single file Multiple files
Mine
Favorite 3
DXF
Shared -
{ [ UG [ FOF
Rendering [ ?‘
{ A
\b 1 Turntable images Blank style
@ WORKROOMS * * * *
cLo CLO18072212 T-shirt1.Zprj CLO18072211 CLO18072211 souvenir JK CLO1705003 CLO1705002
’ v ich pich ’ v
A companies
B MARKETPLACE b
NEXT
g7 L \

CLO1705001 CLO1612001 CLO1610013 CLO1612002 CLO1612003 CLO1501002 CLO1501004 CLO1605028
e Mich fich y

fa

CLO1606015 CLO1606065 CLO160%001 CLO1606045 CLO1605017 CLO1605016 CLO1606046 CLO1501011
ich b

SET



Upload

1) Single file and Multiple files upload

Drag & Drop the file to upload or click 'UPLOAD FROM COMPUTER’ button to select a file.

44 Grading.Zpri
6.7.8. Garme...rovement.Zprj

20184 6% 5% 2 1
20184 5% 282 27 6
20184 48 278 9%
20184 48 272 % 4:07

© Jumper1.Zprj

T Pants2.png

ants2.Zpr

Pantsi2.zpac

_ Sample Harrin...oat ver2.Zprj
7" Sample_Shirt.png

© Sample_Shirt.Zprj

Sample_Suit.Zprj
¥ sample_Tie.png

C sample_Tie.Zprj
| Sample_Vest.png

20188 48 278 0% 4:07
20184 68 5% 9 10:51
20184 58 22 ©% 4:33

20184 58 28 O 4:33

20184 58 8Y 2% 10:40
20184 5% 8Y 27 10:40
20184 68 52 93 10:51
201811 5% 28Y 9% 6:05
20184 58 12 2%
20184 58 112 0%
201841 58 112 2% 5:58
20184 58 112 2% 5:58
201841 58 112 9% 5:40
201811 5% 112 9% 5:40
20184 5% 114 9% 5:55

n Drag & Drop

clo-zprj
clo-zprj
PNG of0lx|
clo-zprj
To-zp1]
clo-zpac
PNG Olalx|
clo-zprj
PNG O[0lx|
clo-zprj
clo-zpac
clo-zprj
PNG Ol0l|
clo-zprj
PNG 0[0[%|
clo-zprj
PNG ofoix|
clo-zpr]
PNG ol0lx|

X
UPLOAD FILE
* STYLE NO.
Drag and drop your files
TAGS
g
o DESCRIPTION
or
* Files must be less than 500mb.
CANCEL
@< s BHom = B 01. CLOSET ) =] Qzm
w40l s ~ 282 EY] ="
H#2ME . 7. 8. Gar..ement.Zprj 20184 58 28% 2% 6:05 83MB  clo-zprj
=B 2018'd 4% 279 2% 4:07 73KB  PNG 0[0lx|
[ cLo work A 4 201811 48 278 2% 4:07 8MB_clo-zprj
Dynasty Muzik 8MB
[ My sources  Dressa.zpac 8.1MB  clo-zpac
_ ¥/ Jumpert.png 201841 5% 2% 9% 4:33 95KB  PNG Oloix|
© se== jumper.Zprj 20184 58 28 9% 4:33 11.9M8  clo-zpr]
/A sez=au T Pants2.png 2018 58 8% 2% 10:40 95KB  PNG OlOI|
@ 23 & Pants2.Zprj 20184 58 82 2 10:40 7.6MB  clo-zprj
&} Michelle 20184 68 5% 97 10:51 7.8MB  clo-zpac
B =a0e 20184 53 282 27 6:05 8.3MB  clo-zprj
2018\ 58 11 2% 5:56 103KB  PNG 0[0X]
=l _ Sample_Shirt.Zprj 201841 52 112 9% 5:56 10.7MB  clo-zprj
T sample_Suit.png 2018\ 58 11% 2% 5:58 151KB  PNG 0|0IX]
‘& Sample_Suit.Zprj 2018\ 58 11 2% 5:58 12.3MB  clo-zprj
4l |

UPLOAD FILE

= Files must be less than 500mb.

CLOSET

Fill out the info and click 'UPLOAD' button.

* STYLE NO.

TAGS

#Knit, #Cardigan, #)

DESCRIPTION

A

After uploading is completed.

|1| UPLOAD ° Q CLO > BRAND > LINE > SEASON > WORKROOM
. l | '
* *
CLO18081611 CLO CLO18072212
Michelle Michelle Michelle
.1. UPLOAD e @ CLO > BRAND > LINE > SEASON > WORKROOM

T

CLO18081611 CLO CLO18072212

Michelle Michelle

CLOSET post-processes the uploaded file for a better service.

As the processing is completed, the thumbnail shows up.

GO TO INDEX



Upload

2) Turntable images upload

*  You can upload high-quality turntable images as well as Zpac file.

»  Create high-quality images in CLO.

D Pattern

Display

Update

Turntable

64

Counter

640 x 480

Render

SET

Select Render > Render in the main menu.

Click Update button.

Select ‘Turntable Images’ in medium and enter image count.

Click Render button.

jk40.0.png jk401.png jk40_2.png k40_3.png k40_4.png k405.png jk40_6.png
479x639  479x639  479x639 479630  479x630  479x630  479x639

jk40_7.png jk40_8.png k40.9.png jK4O....png k4011, 1eng jk4012.png jK40._...png
479 x 639 479 x 639 479 x 639 479 x 639 479 x 639 479 x 639 479 x 639

d...ng jké0.15.0ng jk40....png jk40.17.png jKAO_...png jKAO_..png  jk40...png
479x639  479x639  479x639  479x639  479x639  479x639  479x639

jk40..1.ong jk40...png  jk40...png  jk40...png  k40...png  jk40...png  jk40...7.png
479x639  479x639  479x639  479x639  479x630  479x630  479x639

Specify the folder and file name to save in file browser.

Complete.

- On the next page

GO TO INDEX



Upload

2) Turntable images upload
*  You can upload high-quality turntable images as well as Zpacfile.

+  Create high-quality images in CLO.

Upload images per colorway.

B adannnaa

Ra0.0ng 140 15m5 40 25m 140 S0 Kd0-45m9 K40 530 0 S5m0 UPLOAD TURNTABLE IMAGES

9909 40,009 10 11509 4012909 }

. ‘ ‘ . . . . “STYLE NO.

Colorway1

40,..png k40150 AO...png KAO.7png KAD...png J40,p0g AO..5ng

ftaAaAdaAnAnan

40150 800G KkA0...o0g KAD...png kAD..png ED..png K40 7o #Tag

+  Selectimages to upload
DESCRIPTION

*  Theimages must have the same size

* Files must be less than 500mb.
CANCEL

n Click this button if you want to add a colorway.

After uploading is completed.

n Fill out the info and click 'UPLOAD’ button. &, upLoap [+ 9 CLO > BRAND > LINE > SEASON > WORKROOM
X
UPLOAD TURNTABLE IMAGES
[ J
* STYLE NO.
Colorway1 CLO18081612
*
TAGS
h CLO18081611 CLO18072212
g
. Michelle Michelle Michelle
DESCRIPTION
Iil UPLOAD e 9 CLO > BRAND > LINE > SEASON > WORKROOM

- ADD COLORWAY

* Files must be less than 500mb.
UPLOAD

*
CLO18081612 CLO18072212

Michelle Michelle Michelle

+  CLOSET post-processes the uploaded file for a better service.

*  Asthe processing is completed, the thumbnail shows up

CLOSET

GO TO INDEX



GO TO INDEX

- Upload

3) Create a blank style
*  You can create a style as blank without uploading any files.

+  After creating a blank style, you can upload a file you want

| Select create blank style. . Finished creating a blank style. © Upload within style page.
y 9 Yy P pag
X 4 UPLOAD ° Q CLO > BRAND > LINE > SEASON > WORKROOM
SELECT FILE FORMAT = STYLENO.  Blank style El a
CREATOR & vichelie Aug 16,2018, 02:53 PM 8 qmes
Single file Multiple files 3
VERSIONS &, uPLOAD .
[ oes | [oer | | Oemmmes
Turntable images O Blank style n
Blank style CLO18081612 CLO18081611
Michelle Michelle Michelle
ATTACHMENTS

Please upload a new style

CLOSET



GO TO INDEX

- Upload

4) Direct upload inside CLO Software

*  You can even upload files from CLO directly.

Click Share Project/Garment/Avatar menu in CLO. Then, a web page pops up as below. Here you can select a Workroom to

Then the current project/garment/avatar will be uploaded onto CLOSET. upload the file or an existing Style to upgrade.

o
. Fenale Ttz
ovornes A F B W € =} | AN AR AR Share Project UPLOAD FILE
ot : : z . Share Garment
O Upload a new Style

Share Avatar a

WORKROOM
cLo

Fabric

Hardware and Trims

nT
L

Click ‘Next’ button to proceed. Then, the remaining process is the same as

what you do when uploading a file.

SET



GO TO INDEX
- Create / Delete Workroom

You can create and delete Workrooms within the Season.

. You can create Workrooms in Workroom as well.

You can create Workrooms in Season. Click ‘Delete’ in its context menu.

A A
CLOSET sonour (N CLOSET cenour (8
eE o & &

Q CLO > BRAND LINE > SEASON e Q CLO > BRAND > LINE > SEASON

A STYLES A STYLES

Recent Q Recent Q

Al Al

Mine Mine

(-

Favorite Favorite "

Shared Shared n

Rendering Rendering

A-ove
@ WORKROOMS @ WORKROOMS
WORKROOM NEW WORKR.. WORKROOM

B companies B companiEs

B MARKETPLACE B MARKETPLACE

ABOUT | API | HELP | TERMS UT | API | HELP | TERMS

SET



View

Check Style in detail.

Click a Style thumbnail in Workroom to see details.

Q CLO > BRAND

LINE > SEASON

> WORKROOM

STYLE NO.

CREATOR

T-shirt1.Zprj

@ vichelle

Jul 23,2018,02:17 PM

il
a8
®

VERSIONS

[ TECH PACK

¥, DOWNLOAD

, Teshintl.Zpr

— COLORWAY

T -
? B

— ATTACHMENTS

T B

) ATTACH FILES

[+ |

DESC.

CLOSET

agn

BE B B BR

BE B R B

GO TO INDEX

Common Information : Style no., Creator (first file uploader), Tags, and description.

You can turn on/off email alerts and set the style as favorite .

You can share styles with other people by using links and invitations.

You can view 3D clothing and rendering images in the viewer.

You can render the style in high-quality images by using our Online Rendering service.

You can upload a new version.

You can download the Tech Pack file generated automatically by our data analysis engine.

You can browse all versions.

You can check the colorways and attach some files for each version.



GO TO INDEX

Version Control

Click "UPLOAD’ button to upload a new version. Select the type. The rest of the process is the same as Upload.

VERSIONS @M RENDER ] A uPLOAD %

UPLOAD NEW VERSION

[ TECH PACK ¥, DOWNLOAD
O Singlefile Turntable images
PG | PNG
Michelle, Aug 16, 2018, 04:23 PM ZPAC N R
DXF
7o
T-shirt1.Zprj
[B)
Michelle, Jul 23,2018, 02:17 PM

NCEL NEXT

You can remove the uploaded version from the list.

CLOSET



Render

You can render the style in high-quality images by using our Online Rendering service.

1) Rendering settings
2)Rendering image viewer

3) Rendering list page

Render viewer

SET

n Rendering setting

VERSIONS [}

ENDER A uPLOAD

[ TECH PACK ¥, DOWNLOAD
Michelle, Aug 16, 2018, 0

T-shirt1.Zprj

Michelle, Jul 23,2018, 02:17 PM

1

+ COLORWAY

— ATTACHMENTS Q) ATTACH FILES

GO TO INDEX



Render

1) Rendering settings

. Basically all settings are the same as in CLO software.

Click 'RENDER' button.

»
VERSIONS o & upLoAD

[ TECH PACK | ¥ DOWNLOAD

Michelle, Aug 16, 2018, 04:23 PM

T-shirt1.Zprj
elle

Micl

Jul 23,2018, 02:17 PM

RENDERING SETTINGS

Q¥ RESET

COLORWAY

O ALL Current

TYPE

O Single Image Turntable Images

viewpoINT @ Current View Custom Views

IMAGE SIZE

WIDTH 480 pixels HEIGHT 640 pixels

BACKGROUND

COLOR 'Y Transparency

m RENDER

CLOSET

B O BB BN

You can make rendering images for all colorways or for only the selected colorway in 3D viewer.

You can render a single image or a turntable images.

You can set the image size.

You can render the image on a colored background or a transparent background.

You can reset all settings.

GO TO INDEX



Render

2) Rendering image viewer

*  Youcanzoom in/out the image by mouse wheel scroll, pan by left/middle mouse button drag.

Thumbnail list of all the completed rendering images. By clicking the thumbnail,

you can see the rendered image on the viewer window.

Quick image navigator.

You can download all rendering images in a zip file, delete the current completed
rendering image, and designate the rendering image as the representative

thumbnail of the style.

GO TO INDEX



Render

3) Rendering list page

*  You can browse all rendered images you requested in this page.

CLOSET

9 Rendering
A STYLES
Recent
Al
Mine
Favorite TASK ID STYLE SETTING TIME DOWNLOAD
vorite
Shared n
700 X 1000
START August 13, 2018, 11:09:10 AM n
bf318ddd16 Single Image *
@ WORKROOMS All Colorways TIME 3m 225
co
B compaNIES
480 X 640
START August 13, 2018, 10:04:37 AM
B MARKETPLACE cce2556e85 Single Image &
Single Colorway TIME 175
CLO18072212
b3
e\ 480 X 640
(&) START August 9, 2018, 16:33:38 PM
cafbcle6d2 l Single Image »
Single Colorway TIME 1m 215
PARTH-TRAIFILES
480 X 640
START August 1,2018, 14:15:52 PM
527e9c8049 Single Image K2

CLO18072212

Single Colorway TIME 1m 115

SET

You can move to this rendering list page by clicking

“Rendering’ menu in the left pane.

Clicking the thumbnail allows you to go to the corresponding

Style page.

You can download the rendering images by clicking the

button.

GO TO INDEX



Tech Pack

Our data analysis engine automatically generates a Teck Pack for the style you upload.

n Click the 'TECH PACK' button in the version section to You can view lots of information on each tab of the downloaded Excel file.

download the file.

2 A B © D E F G H
VERSIONS @M RENDER A urLoAD - sione o Po—
2 I 2, Description Pattern / Sloper
n [(ONN(9)]
3 NS Season SEASON Division
[ TECH PACK | ¥, DOWNLOAD
4 Status
6 | Number of Pattern Pieces 11
1 7 | Sewing Thread Usage 222661

Michelle, Aug 13, 2018, 11:03 AM 9

T-shirt1.Zprj

Michelle, Aug 13, 2018, 11:02 AM
10
1
13 | Comments Date
14 Last Modified August 13,2018, 2:03 AM
15 Created August 13, 2018, 2:02 AM
16
18
19
20|
21
4 a Overview | Specification | Cutter's Must B0OM-Colorway0 BOM-Colorway1 BOM-Colorway2 Measurement

CLOSET

GO TO INDEX



Share

There are two ways to share Style and Workroom.
1) Share via URL - Link Share

2) Share via email - People Share

Link share

SHARE

&
o

csion (@t | mmomezr E < SHARE
VERSIONS [Caceenon | ICTERE

O D

1

+ coLorway

 ATTACHMENTS © arracu pues

Off - disabled
© Anyone with the link can view °
Anyone with the link can edit 4

www.clo-set.com/Item/Index/cead6053e59c4

COPY LINK

CLOSET

| LINK | PEOPLE

People share

SHARE

LINK

| PEOPLE |

EMAIL

+ Type to add

7 -

MESSAGE(OPTIONAL)

WHO HAS ACCESS

# CAN EDIT

e

© CAN VIEW

GO TO INDEX



Share

1) Share via URL - Link Share

Click the 'SHARE' button.

svewo.  T-shitl Zprj =
B - Y )

VERSIONS

| TehimZpg

4 coLoRwAY

= ATTACHMENTS

& ownioso

© armacu rues

. By default, the status is ‘Off’ which means that

this style is not allowed to be accessed via URL.

SHARE

| LINK | PEOPLE

2
. O Off-disabled

Anyone with the link can view °
Anyone with the link can edit Vg
www.clo-set.com/Item/Index/efae2c345e054:

CLOSET

You can change the access permission by

selecting the other radio buttons.

X
SHARE
| LINK | PEOPLE
Off - disabled
© Anyone with the link can view °
Anyone with the link can edit 4

www.clo-set.com/Item/Index/cead6053e59c4

COPY LINK

Access permission
. Can view : can view and comment

. Can edit : can view, comment, download and upload

GO TO INDEX

. Once you change the permission,
the ‘COPY LINK' button below is activated for
you to copy the URL.

X
SHARE
Off - disabled
© Anyone with the link can view °
Anyone with the link can edit 4

www.clo-set.com/Item/Index/cead6053e59c4

COPY LINK




GO TO INDEX

- Share

2) Share via email - People Share
*  You can share by entering the email address of the recipient.

*  You can set permissions for people who receive shares.

+  Share to multiple people at once.

Click the 'SHARE' button. Enter the email address of whom you want Click the 'SEND’ button to finish If you want to change the permission for
to share with and select the permission sharing. Then a notification email will the existing users, click the Settings icon in
from the Select menu on the right. And be sent to the email address. the upper right corner.

press 'Enter’ key.

X X X
L0 - BUAND - LN - SEASON - WORKEOOM SHARE SHARE SHARE
STYENO.  T-shirtl.Zprj - n .
e (rEm | cmenems s SHARE
LINK PEOPLE LINK PEOPLE
VERSIONS Successfully transferred
B recn pack & oownioan n EMAIL EMAIL
+ Type to add Vs + Type to add P
o
MESSAGE(OPTIONAL) MESSAGE(OPTIONAL)
+ COLORWAY Can view
© ATTACHMENTS © arracu Fiues
WHO HAS ACCESS Ee) WHO HAS ACCESS o3

# CAN EDIT “ #' CAN EDIT

© CAN VIEW © CAN VIEW

i ‘ =

Access permission
. Can view : can view and comment

. Can edit : can view, comment, download and upload

CLOSET



GO TO INDEX
- Share Workroom

You can share a workroom using its context menu.

. How to share is the same with ‘Share Style’.

You can share a Workroom using its context menu.

2
P B e '
CLOSET oo | g\
° Q CLO > BRAND > LINE > SEASON
STYLES
Recent Q
All
Mine
Favorite
Shared
=/ Delete
Rendering
(2 Move
@ WORKROOMS
WORKROOM NEW WORKR...

H companies

B MARKETPLACE

HELP | TERMS

SET



GO TO INDEX
Comment

You can make a comment and reply to communicate with your collaborators.

When writing a comment, you can mention any collaborators in your

COMMENT Brand. Type with ‘@’ for mention.

To complete making a comment, Click ‘Post’ button.

POST

. View and Reply.
N celine Cancel
e celine@clo3d.com

& dave
dave@clo3d.com

Michelle Aug13,2018,10:18AM
3. task board jpg
24

A NEW VERSION UPDATED

A new version has been updated.

' Xxoxoviviana Jul 24,2018, 10:16 AM R
2. Sample Harringbone Wool Coat ver2.Zprj

@Michelle 1 like beige and white color best among 4 colors.
It's a simple and nice wool coat.

terry Jul 24,2018, 9:40 AM o
2. Sample Harringbone Wool Coat ver2.Zprj

The length of the sleeve pattern and the neck collar has widened. We're going to put it up to a new version.

CLOSET



GO TO INDEX
- Comment

Notification email on Comment and Mention

Notification emails for all comments are sent to all participants on the Style.

Notification emails are sent to the users who are mentioned.

. Notification email on comment and mention. . If you don't want to receive the notification emails, just click the notification icon.

Click to see the comment and mention.

g
P srviewo.  RDWNSUM1901 sdfsdf s ;] |E|*
1} CREATOR o jaden Aug 3,2018,02:17 M

<& sware

M TecHPACK | [l MARKET PLACE &, bownLoAD

RDWNSUM1901.Zprj

Hello Michelle,

Anew comment has been added.

1uly 24,2018, 12:59 AM

xoxoviviana 2.CLO18072212

| like beige and white color best among 4 colors.
It's a simple and nice wool coat.

Best regards,
The CLOSET Team

Copyright © 2018 CLO Virtual Fashion, All rights reserved. hello@clo-set.com

CLO SET

CLOSET



GO TO INDEX

Multi-Select & Delete

b CLOSET

A, upLoAD ° 9 CLO > BRAND > LINE > SEASON > WORKROOM <, SHARE [ LINE SHEET Al v SORTBY | Lastmodified v | ¥

A STYLES

Recent Q

All
Select multiple styles.
' UNsELECT You can select or deselect all from the left floating menu.
* * *
cLo

You can also delete selected styles at once.
CLO18072212 CLO18072211

Mine

Favorite
Shared

Rendering

@ WORKROOMS
Blank style CLO18081612 CLO18081611

H companies
SELECT ALL

B MARKETPLACE

[ &Y

R 4

CLO18072211 souvenir JK CLO1705003 CLO1705002 CLO1705001 CLO1612001 CLO1610013

LINE SHEET

CLO1612002 CLO1612003 CLO1501002 CLO1501004 CLO1605028 CLO1606015 CLO1606065

SET



Multi-Select & Line sheet

Select multiple styles.

Click ‘LINE SHEET' button. Then, CLOSET will generate a Line Sheet excel file only with the selected styles.

9 CLO > BRAND > LINE > SEASON > WORKROOM

STYLES

Recent

Al
Mine
Favorite
Shared

Rendering

WORKROOMS
Blank style CLO18081612

=stirt1 Zprj
. ichal

B companies

B MARKETPLACE

[ B

CLO18072211 souvenir JK CLO1705003

N

CLO1612002 CLO1612003 CLO1501002
h % Michelle

@ unesHEET g v SORTEY | Lastmodified v

(-

UNSELECT
* *
CLO18072212 CLO18072211
I
SELECT ALL
1o
DELETE

CLO1612001 CLO1610013

CLO1606015 CLO1606065
I

SET

An example of Line Sheet generated by CLOSET. If you want to have

your own format of Line Sheet, submit a request to hello@clo-set.com.

8 c [ 3 P G

ao BRAND UNe SEASON WORKROOM

CLO18081611
Wostas o Moataaty oy oo
Aug 162018 444AM Michale Michale it #Cardgan Hocket
oty Black

e

oy .Grey

e

oty Loy

e
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Create Room

Create a Company

B 7 covenns

From the left menu on the dashboard, click 'COMPANIES'.

CLOSET

RECENT STYLES +

A STYLES

Recent

All

Mine

Favorite

Shared

-8 A

T-shirt1Zprj HCO16 CLO18072212 CLO18072211 CLO18072211 souvenir JK

© WORKROOMS

ALL WORKROOMS
@ MARKETPLACE

WORKROOM NEW WORKROOM Workroom Workroom Workroom Public Room

CLO> BR...> SEASON CLO> BR...> SEASON CLO > BR...S5- Men €LO > BR.W - Women CLO> BR..> 2017 FW. co

Click 'CREATE COMPANY’ button. Then a dialog pops up, where you can name the Company.

CLOSET

CREATE COMPANY

9 Companies Last modified v

A STYLES

Recent
Q

Al

Mine
Favorite
Shared

Rendering

@ WORKROOMS

B companies

SET

You can set the logo of Company by specifying an image
file. If any image file is not specified, the logo of the
Company is created from the first letter of the Company

name and the color you specified.

CREATE COMPANY CREATE COMPANY

d

nust be larger than 150x150 pixels * Images must be larger than 150x150 pixels.

GO TO INDEX



Create Room

Create a Brand and Season

*  You can create Brand in Company, and Season in Brand.

. Workroom is automatically created when you create Season.

Click ‘+" icon button to create rooms.

file] Y
CLOSET l‘

A STYLES
Recent

All

Mine
Favorite
Sha

Rendering

@ WORKROOMS
Public Room BRAND

B companies

B MARKETPLACE

. Creata Brand

o Creat a Season

° Creat a Workroom

You can set the logo of Brand/Season by specifying an image file. If any

image file is not specified, the logo of the Brand/Season is created from

the first letter of its name and the color you specified.

CREATE BRAND

* Images must be larger than 200x200 pix

CREATE LINE

3

Line name

SET

X
CREATE BRAND
©
Brand name
* Images must be larger than 200200 pix
X

CREATE SEASON

Season name

CONFIRM

CREATE WORKROOM

Workroom name

CONFIRM

GO TO INDEX



Invite members

Invite Brand Collaborators

*  You can invite new users to your brand as a collaborator.

. You can check if the invited members have accepted or not.

Click the invite button.

& CLOSET

A STYLES
Recent

All

Mine
Favorite
Shared

Rendering

@ WORKROOMS
Public Room

In the Invitation pop-up, first select the brand you want to invite.

Enter the e-mail address of the person you want to invite.

You can check the acceptance status of the collaborator.

Click the Settings icon to edit the collaborator on the admin page.

INVITE COLLABORATORS

SELECT BRAND INVITE COLLABORATORS

BRAND

CURRENT COLLABORATORS BE

There is 8 collaborators.

SET

008

Michelle Park

michelle@clo.co.kr

celine

celine@clo3d.com

celine@foxxing.com

GO TO INDEX



Assign Admin

Assign Brand and Company admin

When you enter the brand list page within the company, you will find the admin setting

icon in the upper left corner.

[5°4)
9 Qcwo
A STYLES
Q
Rendering
@ WoRKROOMS
Public Room BRAND

H compANIES

A MARKETPLACE

On the admin page, click on the second tab, ‘Collaborator’.

You can add a new admin to the right of the Company admin list.

£ GENERAL | COLLABORATOR W TRASH

CcoMPANY

COMPANY ADMIN

No. EMAIL JOINED DATE ACTION

o 1 michelle@clo3d.com sun2,2017  DELETE

On the Collaborator page, under Subtab, select Brand.
Select the brand of the list you want to view.
You can add new brand admins.

You can invite new collaborators.

You can check the acceptance status and send an invitation email again.

If you want, you can delete the collaborator here.

£ GENERAL | @' COLLABORATOR | W TRASH

BRAND

BRAND BRAND v

BRAND ADMIN

n + ApD

NO. EMAIL JOINED DATE ACTION
1 michelle@clo.co.kr Jun 22,2017 i DELETE
7
BRAND COLLABORATOR .
NO. EMAIL INVITED DATE JOINED DATE STATUS ACTION
. n A RESEND
1 michelle@clo.co.kr Aug 07,2018
X CANCEL
2 celine@clo3d.com Jul 18,2017 Jul 18,2017 - & DELETE
. 4 RESEND
3 celine@foxxing.com Jul 18,2017 CANCELED -
i DELETE
4 zoe@clo3d.com Jul 13,2017 Jul 13,2017 & DELETE

SET
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Delete Room

Delete Company, Brand and Season

£ GENERAL

@' COLLABORATOR W TRASH

SPACE

B BRAND

COMPANY

CLO

n & DELETE COMPANY

BRAND NAME

BRAND

LINE

RESGISTERED DATE

Jun 13,2017, 1:20 AM

. i) DELETE BRAND

une on @  Tum ON Line to add another organizational sublevel under Brand.

Click on the first tab of the admin page 'GENERAL'".
‘DELETE COMPANY’ button allows you to delete the Company.

The 'DELETE BRAND' button can be used to delete the selected brand.

GO TO INDEX



Ask how to use CLOSET and

report bugs to hello@clo-set.com


http://clo-set.com



